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Chapter 1 : GENERAL COMMENTS 综述 
1.1     INTRODUCTION 

BhaIn allows the input of any bulkhead arrangement along the ship length. A bulkhead arrangement 
is a set of bulkheads located at the same longitudinal position.沿船长输入任意舱壁 

The bulkhead is described by: 
•   Its geometry and scantling.说明几何形状和规格 
•   Primary and ordinary stiffeners.主要和普通型材 
•   Forward and aftward compartments.首尾分舱 

1.2     A GOOD WAY TO CREATE A BULKHEAD ARRANGEMENT创建舱壁布置 
When creating a new bulkhead arrangement, the following window appears: 

 
Figure 1 : BULKHEAD ARRANGEMENT CREATION 

There are two ways to modelise a bulkhead arrangement:两种方法 
•   Direct input直接输入 
•   From a section来自剖面 
The second way (from a section) is the fastest: it automatically detects the bulkhead geometry based 

on the compartments. It also initializes the compartment data. 
1.3     BHAIN INTERFACE界面 

The module allowing to input the data of a bulkhead is organized around the following application: 
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Figure 2 :BHAIN 

Warning Box : displays warning message when BHAIN detects incoherence in the bulkhead 
definition. 

Bulkhead arrangement view : displays a view of the bulkhead arangement. 
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Chapter 2 : MAIN SECTION DATA 主要剖面数据 

On the Bulkhead Arrangement menu, click on Main Data (Figure 24) to display the Main Bulkhead 
Arrangement 

Data Window. 
2.1     MAIN DATA主数据 

The first tab of the main bulkhead arrangement data window allows to define a identification of 
bulkhead, the X 

longitudinal location of the bulkhead and also the type of section used to define the bulkhead. 

 
Figure 3 : MAIN DATA WINDOW 

2.2     HOLD DATA货舱数据（散货计算压力） 
The second tab of the main bulkhead arrangement data window allows defining the hold data. These 

values have to be filled to calculate bulk pressure. 

 
Figure 4 : HOLD DATA WINDOW 

2.3     SHIP STATE船舶数据 
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Figure 5 : SHIP STATE WINDOW 
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Chapter 3 : BULKHEAD GEOMETRY 舱壁几何 
3.1     INPUT SEQUENCE输入顺序 

There are six main sequences to define the geometry of a bulkhead: 
•   Nodes节点 
•   Primary stiffeners主要扶强材 
•   Secondary stiffeners次要扶强材 
•   Corrugation波形壁 
•   Strakes船底板 
These different sequences of the geometry description may be accessed by the following toolbar as 

follows: 

 
Figure 6 : BHAIN TOOLBAR 

Bulkheads: allows defining the bulkhead name and characteristics. 
Nodes: allows defining the geometry of the bulkhead by a succession of segments. 
Primary Stiffeners: allows locating all the primary stiffeners. 
Ordinary Stiffeners: allows locating all the ordinary stiffeners and to define their scantlings in case of 

a single or double skin bulkhead. 
Corrugation: allows defining geometry of a corrugated bulkhead. Strakes: allows locating strake 

bands and characteristics. Compartments: allows defining forward and aftward compartments. 
All these input sequences are bulkhead-oriented. It means that, inside an input sequence, the data 

are available bulkhead by bulkhead. 
When an input sequence is selected in the toolbar, the program displays generally the data 

corresponding to the current bulkhead. The current bulkhead is the last selected bulkhead. 
They are four ways to move from one bulkhead to another: 
•   a direct click on the desired bulkhead in the bulkhead arrangement view, 
•   the Next Bulkhead and Previous Bulkhead items on the Tools menu (Figure 24), 
•   the F6 key to jump to the next bulkhead or the F5 key to jump to the previous bulkhead, 
•   using the bulkhead list placed on the right-hand corner of BHAIN : 

 
Figure 7 : BULKHEAD LIST 

3.2     CREATION AND DELETION OF DATA数据的创建和删除 
In each input sequence, you can create or delete data: 
•   Bulkheads : creation or deletion of a bulkhead 
•   Nodes : creation or deletion of a segment 
•   Primary stiffeners : creation or deletion of a primary stiffener 
•   Ordinary stiffeners : creation or deletion of a secondary stiffener 
•   Strakes : creation or deletion of a strake band 
Each object has to be created or deleted using the following toolbar: 

 
Figure 8 : CREATION-DELETION TOOLBAR 

For example, if you want to create a new bulkhead 
•   click on the bulkhead button (Figure 6), 
the Bulkhead management window (Figure 9) is displayed, 
•   click on the creation button (Figure 8). Inversely, if you want to delete an existing panel, 
•   click on the bulkhead button (Figure 6), 
•   select the bulkhead you want to delete, 
•   click on the deletion button (Figure 8). 
To create data, it is also possible to hit the F12 key instead of clicking the creation button. 
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Another way to create or delete objects is to use Create object or Delete object on the Tools menu 
(Figure 24) 
3.3     BULKHEAD DATA舱壁数据 

Clicking on the bulkhead button  or on Bulkhead on the Bulkhead arrangement menu (Figure 
24), you enter the Bulkhead management window: 

 
Figure 9 : BULKHEAD MANAGEMENT WINDOW 

In this window, you can create or delete bulkheads using the creation or the deletion buttons (Figure 
8). Identification, a type and material define each bulkhead. Moreover you can enter the stiffeners 
location as regards compartments near to bulkhead and the secondary stiffeners direction. 

Bulkhead Identification: up to 40 characters. 
The bulkhead has to be clearly identified. This identification will appear in input sequences and in 

output of data and results. 
Type: single skin, double skin or corrugated. 
Material: material of bulkhead. 
Stiffeners are located in the: stiffeners location as regards compartments near to bulkhead. 
Ordinary Stiffeners are: ordinary stiffeners direction. 

3.4     NODE BUTTON : GEOMETRY OF THE BULKHEAD节点定义舱壁几何形状 
3.4.1        Nodes and segments节点和线段 

A bulkhead contour is made of contiguous segments of different geometry (straight or circular line). 
Each segment is described by: 

•   its ending node 
•   its type of curve. 

First node of a bulkhead舱壁的第一个节点 

Clicking on the node button  or on Nodes on the Bulkhead arrangement menu (Figure 24), you 
enter the 

Node management window where these inputs are performed: 

 
Figure 10 : NODE MANAGEMENT WINDOW Node  

Creation创建 
The creation button        allows you to create a node extending the bulkhead contour. The deletion 

button        is used to delete nodes. 
It is also possible to insert a node between two existing nodes by clicking on the Tools… menu and 
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selecting 
Insert node (Figure 24). 
Next node - Previous node: Those two buttons allow to navigate node by node within a bulkhead. A 

direct click on the desired node in the bulkhead arrangement view is also possible. 
Node characteristics 
Coordinates of the node (in m): The Y and Z coordinates of the current node. 

Segment characteristics线段特性 
The characteristics of the segment between the current node and the previous one consist in: 
Curve Type: it specifies the type of the segment. 

 : straight line 

 : tangent arc (see 3.4.2.1)  : arc (see 3.4.2.2) 
3.4.2        Circles圆 

There is two ways to define circle: 
•   tangent arc button 
•   arc button 

3.4.2.1              Tangent arc相切 
The Tangent Arc button is a way of defining circular segment tangent to both segments enclosing it. 

Therefore you have to create the nodes for the three segments (the circular one end its adjacent). 
Example of input of bilge with a flat bottom平底输入示例 
For a rise of keel, you enter: 

Node Y Coordinate Z Coordinate Click On 
1 0. 0. to create a node. 
2 - - to create a node. 
3 - - to create a node. 
4 10. 10.  

You should obtained this kind of bulkhead: 

 
Click on segment 2 (node 3) and hit on the Arc Tangent button (Figure 10).The window here after is displayed 
on screen : 

 
R (in m): Radius of the circle 
Figure 11 : TANGENT ARC DATA 

YTan and ZTan (in m) : Y and Z coordinates of the tangent intersection of the enclosing segments. 
The coordinates of the first and the last nodes on this segment are automatically calculated and cannot 
be changed. The result is: 

 
Example of input of bilge with rise of keel斜底输入示例 
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For example, for a rise of keel, you enter: 
Node Y Coordinate Z Coordinate Click On 
1 0. 0. to create a node. 
2 2. 0. to create a node. 
3 - - to create a node. 
4 - - to create a node. 
5 10. 10.  

 

You should obtained this kind of section: 

 
Click on segment 3 (node 4) and hit on the Arc Tangent button (Figure 10). The window here after is 
displayed on screen: 

 
The result is: 

 
3.4.2.2              Arc弧 

The Arc button can be used to define any circular segment. 
The coordinates of the first and the last nodes on this segment have to be input. 
The definition of an arc is completed by means of the window here after. It is displayed on screen, hitting 

arc button when the current node is the last node of the circle 

 
R (in m) : Radius of the circle. 

Figure 19 : ARC DATA 
With this method, you can define any kind of circular segment. For example: 

 
3.5     PRIMARY STIFFENER主要扶强材 

All the primary stiffeners existing on the bulkhead have to be defined by their position and their coordinate. 
They are automatically numbered, starting at number 1 for each bulkhead. 

Clicking on the Primary stiffeners button (Figure 6) or on Primary stiffeners on the Bulkhead Arrangement 
menu 

(Figure 24), you enter the Primary stiffener management window where these inputs are performed: 
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Figure 12 : PRIMARY STIFFENER MANAGEMENT WINDOW 

The creation and the deletion buttons (Figure 8) allow you to create or delete primary stiffeners. Position: 
horizontal or vertical. 

To select a primary stiffener, click on a primary stiffener in the bulkhead arrangement view or in the 
previous/next button. 

Z/Y (in m): coordinate of primary stiffener. 
3.6     SECONDARY STIFFENER次要扶强材 
3.6.1        Location位置 

Clicking on the Secondary Stiffener button (Figure 6) or on Secondary Stiffeners on the Bulkhead 
Arrangement menu (Figure 24), you enter the Secondary Stiffener management window where these inputs 
are performed: 

 
Figure 13 : SECONDARY STIFFENER MANAGEMENT WINDOW 

The location is done by defining a coordinate of stiffener. The creation and the deletion buttons (Figure 6) 
or the Stiffener Wizard button (see 3.6.2) allow you to create or delete stiffener. 

Stiffener List: Display of the stiffeners defined on the current bulkhead and of their scantling. 
The list shows: the stiffener number and its scantling. The stiffeners selected are the current stiffeners. 

Selection of one stiffener选择一个扶强材 
click the stiffener in the Stiffener List or in the Bulkhead Arrangement view. 

Selection of stiffeners that are next to each other选择多个扶强材（shift键） 
select the first stiffener you want to select; hold down the SHIFT key and click the last stiffener you 

want to select. 
select in the list the first stiffener you want to select, hold down the mouse button and drag the 

selection to the last stiffener you want. 
Selection of stiffeners that are not next to each other选择多个扶强材（ctrl键） 

hold down the CTRL key, and then click each stiffener you want to select. 
Material: allows changing the current stiffener material which, by default, is the supporting bulkhead 

one. 
Spacing (in m): spacing of the selected stiffeners. 

3.6.2        Stiffener Wizard 扶强材设定 
The stiffener wizard is the best way to easily define a group of stiffeners regularly spaced. 
Clicking on the Stiffener Wizard button you enter the Secondary stiffeners creation window where 

these inputs are performed: 
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Figure 14 : SECONDARY STIFFENERS CREATION WINDOW 

Start position (in m): 起点coordinate of first stiffener. 第一个扶强材坐标 
Spacing (in m): 间距spacing of considered stiffeners.  
Number: number of considered stiffeners. 

3.6.3        Scantling规格 
Scantling tab列表 

Stiffener Type: allows to select the stiffener type: 

•  : flat stiffener 

•  : bulb stiffener 

•  : angle stiffener 

•  : T-bar stiffener 
In case of flat or bulb type, flange characteristics aren’t available. 
If none type is chosen, the stiffener is considered as a NULL type which is defined in 3.6.4. 
Web Height (in mm): Height of stiffener web (H1). 
Web Thickness (in mm): Thickness of stiffener web (E1). 
Flange Height (in mm): Width of stiffener flange (H2). 
Flange Thickness (in mm): Thickness of stiffener flange (E2). 

 
3.6.4        Null type没有扶强材的类型（不影响舱壁的几何特征） 

A stiffener with NULL type has no effect on the geometric characteristics (areas, inertia, moduli) of the 
bulkhead. 
3.7     CORRUGATION波形 

Choosing a type corrugated for a bulkhead the corrugation button  and Corrugated item on the 
Bulkhead Arrangement menu (Figure 24) become active; clicking on one of these you enter the Corrugation 
management window where these inputs are performed: 
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Figure 27 : CORRUGATION MANAGEMENT 

WINDOW 
3.8     STRAKES船底板（列板） 

Clicking on the Strakes button (Figure 6) or on Strakes on the Bulkhead Arrangement menu (Figure 24), 
you enter the Strake band management window where these inputs are performed: 

 
Figure 15 : STRAKE BAND MANAGEMENT WINDOW 

During a first input, there is a strake automatically created on each bulkhead with width equal to the width 
of the bulkhead. 

The creation and the deletion buttons (Figure 6) in the Tool bar allow you to create or delete vertical 
strakes. 

To create or delete horizontal strakes you have to use the creation and the deletion buttons located in 
Horizontal distribution frame. 

Creating a strake means to divide the strake selected in the strake list (Figure 29) into two strakes of same 
characteristics, thickness and material, and with width equal to the half width. 

Vertical Strake List: display of the number and limit of the strakes defined on the current bulkhead. The 
strake selected is the current strake. To select a strake, click on a strake in the list or in the Bulkhead 
Arrangement view. 

Horizontal Strake List: display of the number, limit and thickness of the strakes defined on the current 
bulkhead. 

The strake selected is the current strake 
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Thickness (in mm): thickness of the current strake. 
Material: material of the current strake. 

3.9     COMPARTMENTS分舱 
Clicking on the compartment button (Figure 13) or on Forward and aftward compartments on the Bulkhead 
Arrangement menu (Figure 24), you enter the Compartments management window: 

 
Figure 16 : COMPARTMENTS MANAGEMENT WINDOW 

In this window, you can define the data for forward and aftward compartments. 
Main destination: main load type. 
Type: choose a compartment type in the list. 
The possible types are: 

1 Tank 
2 Double bottom, skin 
3 Dry compartment 
4 Engine room 
5 Boiler compartment 
6 Tunnel 
7 Hopper well 1 
8 Hopper well 2 

3.9.1        Dimensions 
Clicking on the Dimensions button (Figure 16), the compartment-dimension window is displayed: 

 
Figure 17 : COMPARTMENT-DIMENSION WINDOW 

Breadth (in m): compartment breadth. 
Height (in m): compartment height. 
X start (in m): longitudinal location of start compartment from APP. 
Xg (in m): longitudinal location of compartment center of gravity from APP. 
The following data may be obtained by calculation clicking on Always use compute values check or by 

direct input: 
Yg (in m): center of gravity (Center line). 
Zg (in m): center of gravity above base line. 
Zmin/BL (in m): min of compartment from base line. 
Ztop/BL (in m): top of compartment from base line. 
If you don’t want use the Rule values for highest point / total acceleration click in the related check. The 

window become: 



BhaIn 舱壁布置定义 

13 / 16 

 
Figure 18 : COMPARTMENT-DIMENSION WINDOW (2) 

3.9.2        Loading cases载荷状况 
Clicking on the Loading Cases button (Figure 16), the compartment load window is displayed: 

 
Type: select a load type. 

Figure 19 : COMPARTMENT LOAD WINDOW 
Liquid cargo液货舱 

Load test height (in m): tank testing load height from base line. Air Pipe (in m): distance from top of air 
pipe height to base line. Density liquid: density of liquid cargo. 

Setting pressure (in bar): setting pressure of safety valves. 
Bulk cargo散货舱 

Load in hold (in t): load in hold (bulk or spoil). Density of bulk or spoil (in t): 
density of bulk or spoil. Friction angle (in °): internal friction angle for bulk. 

This input allows to define for the same compartment a liquid cargo and a 
bulk cargo. This facility may be used for ballastable hold in bulk carrier. 
3.10   MENUS菜单 

File Menu文件 
It allows to manage the bulkheads (save, open), to print and to quit BHAIN. 
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Figure 20 :FILE MENU 

 
 
 
 
 
 
 
 
 
 

Item Use Shortcut 
New… Creates a bulkhead.  
Open.. Opens an existing bulkhead. you can also press Ctrl + O. 
Save Saves the opened bulkhead. you can also press Ctrl + S or 
Save As… Saves a copy of the bulkhead with another name.  
Export Drawing Creates a bitmap file from the bulkhead drawing  
Print Data… Prints the data of the bulkhead (see3.12.1). you can also press Ctrl + S or 
Print Drawing… Prints a drawing of a bulkhead (see1.3.2).  
Quit Quits BHAIN to return to MARSHELL. you can also press Ctrl + Q or 

Edit Menu编辑 
It allows to undo the last action or copy the section drawing to 
clipboard. 

 
Figure 21 : EDIT MENU 

Item Use Shortcut 
Undo cancels the last action. Ctrl + Z 
Copy Section Drawing to clipboard allows to paste the section drawing in any other application.  

Bulkhead Arrangement menu舱壁布置菜单 
It gathers the entries to the input fields. 

 
Figure 22 : BULKHEAD ARRANGEMENT MENU 

Item Use Shortcut 
Main data displays the Main Bulkhead Arrangement 

Data Window (see Chapter 2 :). 
 

Bulkhead displays the Bulkhead management window(see 3.3).  
Nodes displays the Nodes management window(see 3.4).  
Primary stiffeners displays the Primary stiffeners management window (see 3.5).  
Secondary stiffeners displays the Secondary stiffeners management window (see 3.6).  
Corrugated displays the Corrugation management window (see 3.7).  
Strakes displays the Strake Band management window (see 3.8).  
Forward and aftward 
compartments 

displays the Forward and aftward compartments management window 
(see 3.9). 

 

Check menu检查 
It includes checking tools. 

 
Figure 23 : CHECK MENU 

Item Use Shortcut 
Check Materials - Strakes displays the strakes with a different color for each material.  
Check Materials - Stiffeners displays the stiffeners with a different color for each material.  
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Check Thickness displays the strakes with a different color for each thickness.  
Check Secondary Stiffeners 
scantling 

displays the secondary stiffeners with a different color for 
each stiffener scantling. 

 

Tools menu :工具 

 
Figure 24 : TOOLS MENU工具菜单 
Item Use Shortcut 
Add object creates data (see 3.2). or F12 
Delete object deletes data (see 3.2).  
Insert node… inserts a node (see 3.4.1 ), this item is available only during the node 

input sequence. 
 

Zoom allows to zoom in (see 3.13).  
Previous bulkhead changes the current bulkhead to the previous one (see 3.1). F5 
Next bulkhead changes the current bulkhead to the next one (see 3.1). F6 

Options menu 

 
Figure 25 : OPTIONS MENU 
Item Use Shortcut 
Preferences… displays a set up window for the section drawing on the screen or a printer.  
Refresh drawing refreshes the screen in case of display anomalies. F9 
3.11 
3.12   PRINTING打印 
3.12.1      Printing data打印数据 
Clicking on  or on Print Data… on the File menu (Figure 20) or pressing Ctrl + P, you enter the Print 
Data management window: 

 
Figure 26 : PRINT DATA MANAGEMENT WINDOW 

This window allows you to select what you want to print. The All (None) button selects (deselects) all the 
items of the list. 
Front page produces the cover page of a report. 
3.12.2      Printing drawing 
Clicking on Print Drawing… on the File menu (Figure 20), you enter the Print Drawing management window: 
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Figure 27 : PRINT DRAWING MANAGEMENT WINDOW 

This window allows you to select which item will be printed on the item. 
The Normalized scale check box will make the drawing printed with a regular scale (e.g. 1/50, 1/100, …). 
3.13   ZOOM视窗 
It is possible to Zoom in on or out of the Bulkhead view thanks to the Zoom Toolbar: 

 
Figure 28 : ZOOM TOOLBAR 

A first click on the Zoom button (Figure 28) or on Zoom on the Tools menu (Figure 24) changes the 
cursor in  and allows you to zoom in the bulkhead view by simple click on it. 
A second click on the Zoom button (Figure 28) or on Zoom on the Tools menu (Figure 24) changes back 
the cursor in  and allows you to work on your zoomed bulkhead view. 
To zoom out of the section view, you can: 
•   click on the No Zoom (1:1) button (Figure 28) to bring back the view to the initial size. 
right-click on the section view when the Zoom button is down. 
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